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ABSTRAKSI 

 

APLIKASI 

GIS (GEOGRAPHIC INFORMATION SYSTEM) BATAM 

STUDI KASUS PERUMAHAN TIBAN BTN 

 

Saat ini GIS (Geographics Information System) dijadikan alat untuk pemetaan dan analisa terhadap 

banyak aktivasi di atas permukaan bumi. GIS mempunayai kemampuan untuk menampilkan peta, dan 

integrasi informasi. GIS dapat digunakan oleh individu atau organisasi seperti perguruan 

tinggi/sekolah, perusahaan, pemerintah, dan masih banyak lagi. 

Buku ini memberikan penjelasan dalam pembuatan Aplikasi GIS (Geographics Information System) 

Batam Studi Kasus Perumahan Tiban BTN, yang disusun secara sistematis dimulai dari latar belakang, 

deskripsi umum sistem, analisis, dan implementasi aplikasi. Juga disertakan lampiran tambahan seperti 

cara pembuatan dan pengubahan tabel pada MapInfo, dan skenarion demo untuk Aplikasi GIS 

(Geographics Information System) Batam Studi Kasus Perumahan Tiban BTN itu sendiri.  

 

Kata Kunci: MapInfo, GIS (Geographic Information System) 
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Bab 1 Pendahuluan 

1.1 Latar Belakang 

Semakin pesatnya kemajuan Kota Batam, semakin bertambah jumlah penduduknya. Sehingga banyak 

sekali perumahan yang bermunculan. 

 

Saat ini pencarian informasi alamat perumahan dan nama pemiliknya masih secara manual yaitu 

melalui Yellow Pages. Pada umumnya Yellow Pages hanya memberikan informasi berupa nama 

pemasang telpon, alamat, no telpon, dan gambar-gambar untuk iklan. Akibatnya banyak sekali 

masyarakat Kota Batam yang belum mengetahui alamat (lokasi) yang mereka cari. 

 

Untuk itu diperlukan adanya sistem informasi yang dinamis dan interaktif, yang membantu masyarakat 

dalam mencari alamat (lokasi) seseorang dan informasi lainnya khususnya di perumahan tiban BTN.   

1.2 Tujuan 

Adapun tujuan dari pembuatan tugas akhir ini adalah membuat aplikasi yang mampu mencari dan 

menampilkan peta beserta Informasinya yang meliputi nama, alamat, nomor telpon, nama perumahan 

dan nama jalan. 

1.3 Batasan Masalah  

Pembahasan tugas akhir dengan judul Aplikasi GIS (Geographics Information System) Batam Studi 

Kasus Perumahan Tiban BTN ini dibatasi oleh hal-hal berikut: 

̇ Mengambil kasus perumahan Tiban BTN. 

̇ Dapat memberikan informasi lokasi yang dicari berupa peta, nama, alamat, nomor telpon, nama 

perumahan, nama jalan. 

1.4 Ikhtisar Buku 

Adapun sistematika pembahasan laporan ini sebagai berikut, yaitu: 

Bab I  Pendahuluan. Meliputi latar belakang, tujuan, batasan masalah,dan ikhtisar buku.  

Bab II  Deskripsi Umum Perangkat Lunak. Meliputi deskripsi umum sistem, karakteristik 

pengguna, dan lingkungan operasi yang mencakupi lingkungan operasional dan lingkungan 

pengembangan, serta aturan penomoran. 

Bab III Analisis. Meliputi deskripsi fungsional yang mencakup konteks diagram, DFD, analisis 

kebutuhan data, dan ER-diagram. 

Bab IV Deskripsi Perancangan. Meliputi deskripsi data,  aturan penamaan dan penomoran, deskripsi 

data, deskripsi fungsional  yang mencakupi struktur menu,dan spesifikasi fungsi dan 

rancangan implementasi fisik yang mencakupi spesifikasi kebergantungan antar layar dan 

struktur direktori dan deskripsi file. 

Bab V Implementasi Dan Pengujian. Meliputi implementasi dan pengujian beserta hasilnya. 

Bab VI Kesimpulan Dan Saran. Meliputi kesimpulan dari hasil membangun aplikasi dan saran 

untuk perbaikan dan pengembangan aplikasi . 
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Bab 2 Deskripsi Umum Aplikasi  

2.1 Deskripsi Umum Sistem  

 

Gambar 2.1 Deskripsi Umum Sistem 

Deskripsi sistem dari aplikasi ini, yaitu  

1. User memasukkan kata kunci (keyword) yang akan dicari ke aplikasi. 

2. Aplikasi mencari informasi berupa nama , alamat, nomor telpon dan nama perumahan di MapInfo. 

2.2 Karakteristik Pengguna 

Tabel  2.1. Kategori Pengguna Aplikasi GIS (Geographics Information System) Batam  

Kategori Pengguna Tugas Hak Akses ke aplikasi Jabatan 

User Mencari 

data  

Mencari data dan menampilkan peta 

beserta informasinya 

Masyarakat Kota 

Batam dan 

Masyarakat luar Kota 

Batam 

2.3 Batasan 

Batasan yang dimiliki oleh sistem adalah: 

1. Sistem ini berjalan di sistem operasi Windows dan bersifat Stand Alone. 

2. Sistem ini menggunakan aplikasi MapInfo dalam pembuatan dan mengubah peta. 

2.4 Lingkungan Operasi  dan Pengembangan 

2.4.1 Lingkungan Operasional 

a. Perangkat keras  

- prosesor: Pentium III atau spesifikasi yang lebih tinggi 

- kebutuhan memori utama minimal : 128 Mb 

b. Operating system: minimal Windows 2000 

2.4.2 Lingkungan pengembangan : 

a. Perangkat keras  

- prosesor: Pentium IV 

- kebutuhan memori: 256 Mb 

b. Operating system: Windows XP 

c. Program/utilities lain: MapInfo, Map Basic, Visual Basic 6 

2.5 Aturan Penomoran 

Aturan penamaan dan penomoran dalam laporan ini sebagai berikut : 

a. Penamaan bab : Bab <nomor bab> diikuti judul bab 

Contoh : Bab I Pendahuluan 

b. Penamaan sub bab : <nomor bab> “.”<nomor sub bab> diikuti judul sub bab 

Contoh : 1.1 Latar Belakang  

c. Penamaan sub sub bab : <nomor bab>”.”<nomor sub bab>”.”<nomor sub sub bab> 

Contoh : 2.3.1 Lingkungan Operasional 

d. Penamaan tabel menggunakan nomor dan diikuti nama tabel 
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Contoh : Tabel 2.1 Kategori Pengguna 

e. Penamaan gambar menggunakan nomor dan diikuti nama gambar 

Contoh : Gambar 2.1 Deskripsi umum Sistem 

f. Penamaan lampiran : Lampiran <abjad> 

Contoh : Lampiran A 

g. Penamaan sub lampiran dimulai dari <abjad> “.”<angka> diikuti judul sub lampiran 

Contoh : A.1 Spesifikasi 

h. Penamaan Fungsi diawali huruf  F<nomor fungsi> ”.” <angka> diikuti nama fungsi 

Contoh : F1.1 Fungsi Simpan Data. 
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Bab 3 Analisis 

3.1 Deskripsi Fungsional 

Dalam deskripsi fungsional akan dibahas proses-proses yang dapat dilakukan oleh Aplikasi GIS 

(Geographics Information System) Batam Studi Kasus Perumahan Tiban BTN. Deskripsi fungsional 

terdiri dari Diagram Konteks dan DFD Level 1. Diagram Konteks merupakan gambaran system secara 

umum. Sedangkan rincian proses akan diterangkan pada DFD Level 1. 

3.1.1 Context Diagram  

 
Gambar 3.1 Context Diagram 

 

 

Aplikasi ini digunakan oleh satu user yaitu masyarakat Kota Batam maupun luar Kota Batam. 

Masyarakat Kota Batam atau Masyarakat luar Kota Batam akan memberikan inputan ke aplikasi 

berupa keyword. Aplikasi akan mencari dan menampilkan peta(lokasi) beserta informasi lainnya 

berdasarkan keyword.  

3.1.1.1 DFD Level 1  

 
Gambar 3.2 DFD Level 1 Aplikasi GIS (Geographics Information System) Batam 
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Pada DFD level 1 dijelaskan proses-proses yang dapat dilakukan oleh sistem. 

Proses Cari Lokasi Perumahan 

Pada proses ini, pengguna akan memberikan data (nama perumahan) yang ingin dicari. Aplikasi akan 

memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh pengguna yang berupa 

peta. 

Proses Cari Lokasi Rumah (Alamat) 

Pada proses ini, pengguna akan memberikan data (nama perumahan, alamat) yang ingin dicari. 

Aplikasi akan memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh pengguna 

yang berupa peta. 

Proses Cari Lokasi Jalan 

Pada proses ini, pengguna akan memberikan data (nama jalan) yang ingin dicari. Aplikasi akan 

memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh pengguna yang berupa 

peta. 

Proses Cari Lokasi Tempat Ibadah 

Pada proses ini, pengguna akan memberikan data (nama dan jenis tempat ibadah) yang ingin dicari. 

Aplikasi akan memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh pengguna 

yang berupa peta. 

Proses Cari Lokasi Pasar 

Pada proses ini, pengguna akan memberikan data (nama atau alamat pasar) yang ingin dicari. Aplikasi 

akan memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh pengguna yang 

berupa peta. 

Proses Cari Lokasi Balai Pengobatan 

Pada proses ini, pengguna akan memberikan data (nama atau alamat balai pengobatan) yang ingin 

dicari. Aplikasi akan memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh 

pengguna yang berupa peta. 

Proses Cari Lokasi Sekolah 

Pada proses ini, pengguna akan memberikan data (nama atau alamat sekolah) yang ingin dicari. 

Aplikasi akan memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh pengguna 

yang berupa peta. 

Proses Cari Rumah Penduduk 

Pada proses ini, pengguna akan memberikan data (nama penduduk) yang ingin dicari. Aplikasi akan 

memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh pengguna yang berupa 

peta. 

Proses Cari Lokasi Kelurahan 

Pada proses ini, pengguna akan memberikan data (nama atau alamat kelurahan) yang ingin dicari. 

Aplikasi akan memberikan seluruh informasi data GIS berdasarkan data yang diberikan oleh pengguna 

yang berupa peta. 

3.2 Analisis Kebutuhan Data 

3.2.1 3.2.1 E-R Diagram 

Aplikasi ini menggunakan database yang ada pada software MapInfo. 
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Bab 4 Deskripsi Perancangan 

4.1 Deskripsi Data 

Aplikasi ini menggunakan database yang dimiliki oleh MapInfo. 

Tabel 4.1 Daftar Tabel Deskripsi Data  

Aplikasi GIS (Geographics Information System) Batam 

No Nama Tabel Deskripsi isi 

1 Perumahan Informasi perumahan 

2 Rumah (Alamat) Alamat rumah dan pemiliknya 

3 Jalan Nama Jl Perumahan 

4 Tempat Ibadah letak tempat ibadah 

5 Pasar Letak pasar 

6 Balai Pengobatan Letak balai pengobatan 

7 Sekolah Nama sekolah dan alamatnya 

8 Penduduk Informasi penduduk di perumahan 

9 Kelurahan Letak kelurahan  

4.1.1 Definisi Domain/Type  

Tidak ada 

4.1.2 Daftar Tabel Aplikasi  

Aplikasi ini menggunakan database yang ada di MapInfo, diantaranya adalah: 

Tabel  4.2  Daftar Tabel Basisdata  

Aplikasi GIS (Geographics Information System) Batam  

No Nama Tabel Data Store Deskripsi isi 

1 Perumahan 

 

Informasi perumahan (nama perumahan + 

peta) 

2 Rumah 

 

Informasi  alamat rumah (alamat + jalan + 

no telp + peta + nama perumahan) 

3 Jalan 

 

Informasi jalan (nama jalan + peta)  

4 Tempat Ibadah 

 

Informasi  tempat ibadah (nama tempat 

ibadah + jenis + alamat + jalan + peta) 

5 Pasar 

 

Informasi pasar (nama pasar + peta) 

6 Balai Pengobatan 

 

Informasi balai pengobatan (nama balai 

pengobatan + alamat + no telp + jalan + 

peta) 

7 Sekolah 

 

Informasi sekolah (nama sekolah + alamat 

+ jalan + no telp + peta) 

8 Penduduk 

 

Informasi penduduk (nama penduduk + 

nama perumahan + alamat + peta) 

9 Kelurahan 

 

Informasi kelurahan (nama + alamat + jalan 

+ no telp + peta) 
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4.2 Dekomposisi Fungsional Modul 

Tabel. 4.3 Input-Proses-Output  

Aplikasi GIS (Geographics Information System) Batam 

N

o 

No. 

Fungsi 

Fungsi/Proses Tabel 

Input 

Data Input Tabel  Output Data output Keterangan 

1 F1 Cari Perumahan MapInfo Nama perumahan MapInfo Peta + Pesan  

2 F2 Cari Rumah (Alamat) MapInfo Alamat + nama perumahan MapInfo Peta + No telp + Jalan + Pesan  

3 F3 Cari  Jalan MapInfo Nama jalan MapInfo Peta + Pesan  

4 F4 Cari Tempat Ibadah MapInfo Nama tempat ibadah + 

Jenis 

MapInfo Peta + Alamat + Jalan + Pesan  

5 F5 Cari Pasar MapInfo Nama pasar MapInfo Peta  + Pesan  

6 F6 Cari Balai Pengobatan MapInfo Nama balai pengobatan  MapInfo Peta + Alamat + No telp + Jalan + Pesan  

7 F7 Cari  Sekolah MapInfo Nama sekolah + Alamat MapInfo Peta + Alamat + No telp + Pesan  

8 F8 Cari Peduduk MapInfo Nama penduduk + Nama 

perumahan 

MapInfo Peta + Alamat + Jalan + No telp + Pesan  

9 F9 Cari  Kelurahan MapInfo Nama kelurahan MapInfo Peta + Alamat + Jalan + No_telp + 

Pesan 
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4.3 Spesifikasi Kebergantungan Antar Layar  

 

4.4 Struktur Menu  

 
Aplikasi GIS (Geographics Information System) Batam  

----- Perumahan 

----- Rumah  

----- Jalan 

----- Tempat Ibadah 

----- Pasar 

----- Balai Pengobatan 

----- Sekolah 

----- Penduduk 

----- Kelurahan 

----- Help 

----- Move 

----- Pointer 

----- Zoom In 

----- Zoom Out 

----- Ruler 

----- Radius 

----- Info 
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Bab 5 Implementasi dan Pengujian 

5.1 Spesifikasi Kebergantungan Antar Modul  

Tabel 5.1 Daftar Modul  

Aplikasi GIS (Geographics Information System) Batam  

Nama Modul Deskripsi 

Browser 

MapBasic 

PrintOut 

Untuk menghubungkan antara MapIfo dengan Visual Basic 

 

5.2 Struktur Direktori dan Deskripsi File 

Tabel 5.1 Daftar Direktori dan File  

Aplikasi GIS (Geographics Information System) Batam  

Nama Direktori Nama File Nama Modul Nama Fungsi Keterangan 

Cari perumahan 

Cari sekolah 

Browser.bas 

Cari kelurahan 

Cari jalan 

Cari rumah 

(alamat) 

MapBasic.bas 

Cari balai 

pengobatan 

Cari pasar 

Cari tempat 

ibadah 

Aplikasi GISBSKTB.vbw 

PrintOut.bas 

Cari penduduk 

3 modul menjadi 

sebuah file yang 

terdiri dari 9 fungsi 

Data BTN.wor - - Tidak ada nama 

modul dan nama 

fungsi sebab isinya 

hanya data dan indeks 

Sub bab ini selanjutnya mengacu ke Lampiran C 

5.3 Pengujian dan Hasilnya 

Pengujian dilakukan setelah implmentasi selesai seluruhnya. 
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Bab 6 Kesimpulan dan Saran 

6.1 Kesimpulan 

Kesimpulan yang dapat di ambil dari aplikasi ini adalah: 

1. Aplikasi ini mampu melakukan pencarian data yang ada pada MapInfo dan menampilkan peta beserta 

informasi lainnya yang berupa nama perumahan, alamat, tempat ibadah, sekolah, pasar, nama 

penduduk, kelurahan, balai pengobatan dan no telp. 

2. Menu tambahan seperti  zoom in, zoom out, pointer, geser layar (move), radius dapat digunakan. 

3. Menu jarak (ruler) belum sesuai dengan jarak yang sebenarnya. 

4. Legenda dapat dilihat melalui MapInfo. 

5. Data harus akurat dalam pencarian informasi. 

6.2 Saran 

Saran untuk pengembang aplikasi ini adalah 

1. Menu jarak dapat mengukur jarak yang sebenarnya.  
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Lampiran A Perancangan Rinci Tabel 

A.1. Spesifikasi Tabel Perumahan 

Nama Tabel : Perumahan 

Deskripsi Isi : Berisi informasi perumahan 

Perkiraan laju : ± 5 record per tahun 

Volume  : ± 100 record 

Daftar Field 

Nama Field Deskripsi Isi Type & Length Boleh NULL Default 

Nama_perumahan Berisi nama dan shape perumahan Varchar(25)   

A.2. Spesifikasi Tabel Rumah (Alamat) 

Nama Tabel : Rumah(Alamat) 

Deskripsi Isi : Berisi informasi rumah 

Perkiraan laju : ± 5 record per 5 tahun 

Volume  : ± 100 record 

Daftar Field 

Nama Field Deskripsi Isi  Type & Length Boleh NULL Default 

Nama_perum Nama perumahan Varchar (25)   

Alamat Alamat (blok dan no) Varchar (25)   

Jalan Jalan  yang ada di perumahan Varchar (25)   

No_telp No telp  Varchar (10)   

A.3. Spesifikasi Tabel Jalan 

Nama Tabel : Jalan 

Deskripsi Isi : Berisi informasi jalan 

Perkiraan laju : ± 2 record per tahun 

Volume  : ± 100 record 

Daftar Field 

Nama Field Deskripsi Isi  Type & Length Boleh NULL Default 

Nama_jalan Nama jalan Varchar(25)   

A.4. Spesifikasi Tabel Tempat Ibadah 

Nama Tabel : Tempat_ibadah 

Deskripsi Isi : Berisi informasi tempat ibadah 

Perkiraan laju : ± 1 record per 5 tahun 

Volume  : ± 100 record 

Daftar Field 

Nama Field Deskripsi Isi  Type & Length Boleh NULL Default 

Nama_tempatibadah Nama tempat ibadah Varchar (25)   

Jenis Jenis tempat ibadah Varchar (25)   

Alamat Alamat tempat ibadah Varchar (25)   
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A.5. Spesifikasi Tabel Pasar 

Nama Tabel : Pasar 

Deskripsi Isi : Berisi informasi pasar 

Perkiraan laju : ± 1 record per 5 tahun 

Volume  : ± 10 record 

Daftar Field 

Nama Field Deskripsi Isi  Type & Length Boleh 

NULL 

Default 

Nama_pasar Nama pasar Varchar (25)    

A.6. Spesifikasi Tabel Balai Pengobatan 

Nama Tabel : Balai_Pengobatan 

Deskripsi Isi : Berisi informasi balai pengobatan 

Perkiraan laju : ± 1 record per 5 tahun 

Volume  : ± 10 record 

Daftar Field 

Nama Field Deskripsi Isi  Type & Length Boleh 

NULL 

Default 

Nama_balaipengobatan  Nama balai pengobatan Varchar (25)   

Alamat Alamat balai pengobatan Varchar (25)    

No_telp No telp balai pengobatan Varchar  (25)   

Jalan Jalan Balai pengobatan Varchar  (25)   

A.7. Spesifikasi Tabel Sekolah 

Nama Tabel : Sekolah 

Deskripsi Isi : Berisi informasi sekolah 

Perkiraan laju : ± 1 record per 5 tahun 

Volume  : ± 10 record 

Daftar Field 
Nama Field Deskripsi Isi  Type & Length Boleh 

NULL 

Default 

Nama_Sekolah Nama sekolah Varchar (25)   

Alamat Alamat sekolah Varchar (25)    

No_telp No telp sekolah Varchar (25)   

Jalan Nama jalan sekolah Varchar  (25)   

A.8. Spesifikasi Tabel Penduduk 

Nama Tabel : Penduduk 

Deskripsi Isi : Berisi informasi penduduk 

Perkiraan laju : ± 10 record per tahun 

Volume  : ± 1000 record 

Daftar Field 
Nama Field Deskripsi Isi  Type & Length Boleh 

NULL 

Default 

Nama_penduduk Nama penduduk Varchar (25)   

Alamat Alamat yang dihuni Varchar (25)   

No_telp No telp rumah yang dihuni Varchar (25)   

Nama_perumahan Nama perumahan Varchar (25)   

Jalan Nama jalan penduduk Varchar (25)   
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A.9. Spesifikasi Tabel Kelurahan 

Nama Tabel : Kelurahan 

Deskripsi Isi : Berisi informasi kelurahan 

Perkiraan laju : ± 1 record per 5 tahun 

Volume  : ± 10 record 

Daftar Field 
Nama Field Deskripsi Isi  Type & Length Boleh 

NULL 

Default 

Nama_kelurahan Nama kelurahan Varchar (25)   

Alamat Alamat kelurahan Varchar (25)   

No_telp No telp kelurahan Varchar (25)   

Jalan Nama jalan kelurahan Varchar (25)   
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Lampiran B Perancangan Rincian Fungsional  

B.1. Spesifikasi Fungsi/Proses F1 
Identifikasi/Nama   : F1 

Deskripsi Isi  : Cari Perumahan 

Jenis  : Form Entry columnar 

B.1.1. Spesifikasi tabel input  

Nama Tabel : Perumahan 

B.1.2. Spesifikasi tabel Output  

Nama Tabel : Perumahan 

B.1.3. Spesifikasi Layar Utama 

 

B.1.4. Spesifikasi Query  

Perumahan : Select * from Perumahan where nama_perumahan=cbnmperumahan 

B.1.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama Perumahan Nama_perumahan Perumahan I Varchar      



B.1.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

Cmdfindperumahan CommandButton Jika diklik, akan mengaktifkan fungsi cari perumahan 

Cmdclear1 CommandButton Menghapus data pada Cbnmperumahan 

Cari_perum Label Jika di klik mengaktifkan F_cari_perum 

Cmdexit CommandButton Keluar/menghentikan program 

B.1.7. Spesifikasi layar pesan 

Kasus Pesan 

Data tidak ada pada map Maaf Data Tidak Ada 

B.1.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbnmperumahan > 0) then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah 

   Else 

      Muncul Pesan 

   End if 

   Muncul Informasi 

Enf if 

B.1.9. Spesifikasi Report 

Tidak ada 



B.2. Spesifikasi Fungsi/Proses F2 
Identifikasi/Nama   : F2 

Deskripsi Isi  : Cari Rumah (Alamat) 

Jenis  : Form Entry columnar 

B.2.1. Spesifikasi tabel input  

Nama Tabel : Alamat  

B.2.2. Spesifikasi tabel Output  

Nama Tabel : Alamat 

B.2.3. Spesifikasi Layar Utama 

 

B.2.4. Spesifikasi Query  

Alamat : Select * from Alamat where nama_perumahan = Cbnmperumahan And Alamat = Cbalamat 

B.2.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama Perumahan Nama_perumahan Alamat I Varchar      

Alamat Alamat Alamat I Varchar   

Jalan Jalan Alamat O Varchar   

No Telp No_telp Alamat O Varchar   



B.2.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

Cmdfindalamat CommandButton Jika diklik, akan mengaktifkan fungsi cari Alamat 

Cmdclear2 CommandButton Menghapus data pada Cbalamat 

Cari_alamat Label Jika di klik mengaktifkan F_cari_alamat 

Cmdexit CommandButton Keluar/menghentikan program 

B.2.7. Spesifikasi layar pesan 

Kasus Pesan 

Data lebih dari 1 Alamat Yang Anda Masukan Tidak Lengkap 

B.2.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbperum > 0 and panjang text pada Cbalamat > 0) then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah  

   Else 

      Muncul pesan 

   End if 

   Muncul Informasi 

Enf if 

B.2.9. Spesifikasi Report 

Tidak ada 



B.3. Spesifikasi Fungsi/Proses F3 
Identifikasi/Nama   : F3 

Deskripsi Isi  : Cari Jalan 

Jenis  : Form Entry columnar 

B.3.1. Spesifikasi tabel input  

Nama Tabel : Jalan  

B.3.2. Spesifikasi tabel Output  

Nama Tabel : Jalan 

B.3.3. Spesifikasi Layar Utama 

 

B.3.4. Spesifikasi Query  

Jalan : Select * from Jalan where Nama_jalan=Cbnmjalan 

B.3.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama Jalan Nama_jalan Jalan I Varchar      

 



B.3.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

Cmdfindjalan CommandButton Jika diklik, akan mengaktifkan fungsi cari Jalan 

Cmdclear3 CommandButton Menghapus data pada Cbnmjalan 

Cari_jalan Label Jika di klik mengaktifkan F_cari_alamat 

Cmdexit CommandButton Keluar/menghentikan program 

 

B.3.7. Spesifikasi layar pesan 

Kasus Pesan 

Data tidak ada pada map Maaf Data Tidak Ada 

B.3.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbnmjalan > 0) then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah 

   Else 

      Muncul Pesan 

   End if 

   Muncul Informasi 

Enf if 

B.3.9. Spesifikasi Report 

Tidak ada 

 



B.4. Spesifikasi Fungsi/Proses F4 
Identifikasi/Nama   : F4 

Deskripsi Isi  : Cari Tempat Ibadah 

Jenis  : Form Entry columnar 

B.4.1. Spesifikasi tabel input  

Nama Tabel : Tempat_Ibadah 

B.4.2. Spesifikasi tabel Output  

Nama Tabel : Tempat_Ibadah 

B.4.3. Spesifikasi Layar Utama 

 

B.4.4. Spesifikasi Query  

Tempat_ibadah : Select * from Tempat_Ibadah where Nama_tempat ibadah=nama_tempatibadah and 

Jenis=jenis 

B.4.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama Masjid Nama_tempat ibadah Tempat_Ibadah I Varchar      

Nama Gereja Nama_tempat ibadah Tempat_Ibadah I Varchar      

Alamat Nama_tempat ibadah Tempat_Ibadah O Varchar      

Jalan Nama_tempat ibadah Tempat_Ibadah  Varchar      



B.4.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

Cmdfindmasjid Button Jika diklik, akan mengaktifkan fungsi cari tempat ibadah 

Cmdclear4a Button Mnghapus data pada Cbnmmasjid, txtaddmasjid, dan 

txtjalan 

Cmdfindgereja Button Jika di klik ekan mengaktifkan fungsi cari tempat ibadah  

Cari_tempatibadah Label Jika di klik mengaktifkan F_cari_tempatibadah 

B.4.7. Spesifikasi layar pesan 

Kasus Pesan 

Data tidak ada pada map Maaf Data Tidak Ada 

B.4.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbnmmasjid > 0 Or panjang text pada Cbnmgereja > 0) 

then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah 

   Else 

      Muncul pesan 

   End if 

   Muncul Informasi 

Enf if 

B.4.9. Spesifikasi Report 

Tidak ada 



B.5. Spesifikasi Fungsi/Proses F5 
Identifikasi/Nama   : F5 

Deskripsi Isi  : Cari Pasar 

Jenis  : Form Entry columnar 

B.5.1. Spesifikasi tabel input  

Nama Tabel : Pasar 

B.5.2. Spesifikasi tabel Output  

Nama Tabel : Pasar 

B.5.3. Spesifikasi Layar Utama 

 

B.5.4. Spesifikasi Query  

Pasar : Select * from Pasar where Nama_pasar=Cbnmpasar 

B.5.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama Jalan Nama_jalan Jalan I Varchar      

 



B.5.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

Cmdfindpasar Button Jika diklik, akan mengaktifkan fungsi cari pasar 

Cmdclear5 Button Mnghapus data pada Cbnmpasar  

Cari_pasar Label Jika diklik mengaktifkan F_cari_pasar 

B.5.7. Spesifikasi layar pesan 

Kasus Pesan 

Data tidak ada pada map Maaf Data Tidak Ada 

B.5.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbnmpasar > 0) then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah 

   Else 

      Muncul pesan 

   End if 

   Muncul Informasi 

Enf if 

B.5.9. Spesifikasi Report 

Tidak ada 



B.6. Spesifikasi Fungsi/Proses F6 
Identifikasi/Nama   : F6 

Deskripsi Isi  : Cari Balai Pengobatan 

Jenis  : Form Entry columnar 

B.6.1. Spesifikasi tabel input  

Nama Tabel : Balai_Pengobatan 

B.6.2. Spesifikasi tabel Output  

Nama Tabel : Balai_Pengobatan 

B.6.3. Spesifikasi Layar Utama 

 

B.6.4. Spesifikasi Query  

Balai_pengobatan : Select * from Balai_Pengobatan where 

Nama_balaipengobatan=Cbnmbalaipengobatan 



B.6.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama Balai 

Pengobatan 

Nama_balai

pengobatan 

Balai_Pengobatan I Varchar (25)     

Alamat Alamat Balai_Pengobatan O Varchar (25)     

Jalan Jalan Balai_Pengobatan O Varchar (25)     

No Telp No_telp Balai_Pengobatan O Varchar (25)     

B.6.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

Cmdfindbalaipengobatan Button Jika diklik, akan mengaktifkan fungsi cari 

balaipengobatan 

Cmdclear6 Button Menghapus data pada Cbnmbalaipengobatan, 

Txtaddbalaipengobatan, Txtjlnbalaipengobatan, 

Txtnotelpbalaipengobatan 

Cari_balaipengobatan Label Jika di klik mengaktifkan F_cari_balaipengobatan 

B.6.7. Spesifikasi layar pesan 

Kasus Pesan 

Data tidak ada pada map Maaf Data Tidak Ada 

B.6.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbnmbalaipengobatan > 0) then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah 

   Else  

      Muncul Pesan 

   End if 

   Muncul Informasi 

Enf if 

B.6.9. Spesifikasi Report 

Tidak ada 



B.7. Spesifikasi Fungsi/Proses F7 
Identifikasi/Nama   : F7 

Deskripsi Isi  : Cari Sekolah 

Jenis  : Form Entry columnar 

B.7.1. Spesifikasi tabel input  

Nama Tabel  : Sekolah 

B.7.2. Spesifikasi tabel Output  

Nama Tabel : Sekolah 

B.7.3. Spesifikasi Layar Utama 

 

B.7.4. Spesifikasi Query  

Sekolah : Select*from Sekolah where Nama_sekolah=Cbnmsekolah 

B.7.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama 

Sekolah 

Nama_sekolah Sekolah I Varchar (25)        

Alamat Alamat Sekolah O Varchar (25)        

Jalan Jalan Sekolah O Varchar (25)        

No Telp No_telp Sekolah O Varchar (25)        



B.7.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

CmdfindSekolah Button Jika diklik, akan mengaktifkan fungsi cari Sekolah 

Cmdclear7 Button Menghapus data pada Cbnmsekolah, Txtaddsekolah, 

Txtjlnsekolah, Txtnotelpsekolah 

Cari_sekolah Label Jika di klik mengaktifkan F_cari_sekolah 

B.7.7. Spesifikasi layar pesan 

Kasus Pesan 

Data tidak ada pada map Maaf Data Tidak Ada 

B.7.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbskolah > 0) then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah 

   End if 

   Muncul Informasi 

Enf if 

B.7.9. Spesifikasi Report 

Tidak ada 



B.8. Spesifikasi Fungsi/Proses F8 
Identifikasi/Nama   : F8 

Deskripsi Isi  : Cari Penduduk 

Jenis  : Form Entry columnar 

B.8.1. Spesifikasi tabel input  

Nama Tabel : Penduduk 

B.8.2. Spesifikasi tabel Output  

Nama Tabel : Penduduk 

B.8.3. Spesifikasi Layar Utama 

 

B.8.4. Spesifikasi Query  

Penduduk : Select * from Penduduk where Nama_penduduk = Cbnama And Nama_perum = 

Cbnmperum 



B.8.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama  Nama_penduduk Penduduk I Varchar (25)     

Alamat Alamat Penduduk O Varchar (25)     

Jalan Jalan Penduduk O Varchar (25)     

No Telp No_telp Penduduk O Varchar (25)     

Nama 

Perumahan 

Nama_perum Penduduk I Varchar (25)   

B.8.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

Cmdfindpenduduk Button Jika diklik, akan mengaktifkan fungsi cari penduduk 

Cmdclear8 Button Menghapus data pada Cbnmpenduduk, Txtaddpenduduk, 

Txtjlnpenduduk, Txtnotelppenduduk, Cbnmperum 

Cari_penduduk Label Jika di klik mengaktifkan F_cari_penduduk 

B.8.7. Spesifikasi layar pesan 

Kasus Pesan 

Data lebih dari 1 Maaf banyak penduduk yang memiliki nama yang sama. 

B.8.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbnama > 0 And panjang text pada Cbnmperum > 0) then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah 

   Else 

      Muncul Pesan 

   End if 

   Muncul Informasi 

Enf if 

B.8.9. Spesifikasi Report 

Tidak ada 



B.9. Spesifikasi Fungsi/Proses F9 
Identifikasi/Nama   : F9 

Deskripsi Isi  : Cari Kelurahan 

Jenis  : Form Entry columnar 

B.9.1. Spesifikasi tabel input  

Nama Tabel  : Kelurahan 

B.9.2. Spesifikasi tabel Output  

Nama Tabel : Kelurahan 

B.9.3. Spesifikasi Layar Utama 

 

B.9.4. Spesifikasi Query  

Kelurahan  : Select * from Kelurahan where Nama_kelurahan = Cbnmkelurahan 

B.9.5. Spesifikasi field data pada layar 

Label  Field Tabel/ 

Query 

I/O Format Validasi Keterangan 

Nama 

Kelurahan 

Nama_kelurahan Kelurahan I Varchar (25)        

Alamat Alamat Kelurahan O Varchar (25)        

Jalan Jalan Kelurahan O Varchar (25)        

No Telp No_telp Kelurahan O Varchar (25)        

 



B.9.6. Spesifikasi Function Key/Objek-Objek pada layar 

Id_Objek  Jenis Keterangan 

Cmdfindkelurahan Button Jika diklik, akan mengaktifkan fungsi cari kelurahan 

Cmdclear9 Button Menghapus data pada Cbnmkelurahan, Txtadd kelurahan, 

Txtjlnkelurahan, Txtnotelpkelurahan 

Cari_kelurahan Label Jika di klik mengaktifkan F_cari_kelurahan 

B.9.7. Spesifikasi layar pesan 

Kasus Pesan 

Data tidak ada pada map Maaf Data Tidak Ada 

B.9.8. Spesifikasi proses/algoritma 
Initial State (IS): 

- 

Final State (FS): 

Lokasi yang akan dicari 

Spesifikasi Proses/algoritma: 

If (panjang text pada Cbnmkelurahan > 0) then 

   MapInfo melakukan pencarian 

   If (ketemu=1) then 

      Lokasi di tampilkan di tengah’ 

   Else  

      Muncul pesan 

   End if 

   Muncul Informasi 

Enf if 

B.9.9. Spesifikasi Report 

Tidak ada 
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Lampiran C DAFTAR RINCI FILE DAN DATA 

C.1. Struktur direktori 

C.1.2. Direktori pengembangan 

Direktori pengembangan berada dalam direktori TA IF-0607-1.16 yang didalamnya terdiri dari: 

̇ Aplikasi, berisi data yang dipakai aplikasi (*.DAT, *.TAB, *.MAP, *.ID, *.IND, *.WOR, *.VBP, 

*VBW, *.BAS, *.MB, *.MBX, *.FRM, *.FRX) 

̇ Dokumentasi, berisi semua dokumentasi yang berhubungan dengan Tugas Akhir ini (*.DOC, 

*.VSD) 

C.1.3. Direktori operasional 

Berisi struktur direktori jika aplikasi ini kelak diinstal di komputer pemakai. Minimal berisi 2 buah 

direktori di bawah root : 

̇ ExeFiles, berisi semua executable file 

̇ Data, berisi data yang dipakai aplikasi 

C.2. Isi Direktori: C:\ TA IF-0607-1.16 
E:\Kuliah RCK\TA IF-0607-1.16>dir 
 Volume in drive E is RCK 
 Volume Serial Number is 7436-DA4C 
 
 Directory of E:\Kuliah RCK\TA IF-0607-1.16 
 
12/01/2007  22:32    <DIR>          . 
12/01/2007  22:32    <DIR>          .. 
17/01/2007  04:34    <DIR>          Aplikasi 
12/01/2007  22:32    <DIR>          Dokumentasi 
               0 File(s)              0 bytes 
               4 Dir(s)   2.978.955.264 bytes free 

C.2.1. Isi Subdirektori : C:\ TA IF-0607-1.16\Aplikasi 
E:\Kuliah RCK\TA IF-0607-1.16\Aplikasi>dir 
 Volume in drive E is RCK 
 Volume Serial Number is 7436-DA4C 
 
 Directory of E:\Kuliah RCK\TA IF-0607-1.16\Aplikasi 
 
17/01/2007  19:24    <DIR>          . 
17/01/2007  19:24    <DIR>          .. 
17/01/2007  03:43               936 Alamat.DAT 
17/01/2007  03:00                36 Alamat.ID 
17/01/2007  03:43             3.072 Alamat.IND 
17/01/2007  03:00             1.536 Alamat.MAP 
17/01/2007  03:43               251 Alamat.TAB 
14/01/2007  21:09         5.373.952 Aplikasi GISBSTPTB.exe 
17/01/2007  04:34               848 Aplikasi GISBSTPTB.vbp 
17/01/2007  19:44               157 Aplikasi GISBSTPTB.vbw 
17/01/2007  04:34               848 Aplikasi GISBSTPTB1.vbp 
17/01/2007  04:34               154 Aplikasi GISBSTPTB1.vbw 
17/01/2007  00:50               268 Balai_Pengobatan.DAT 
17/01/2007  00:50                 4 Balai_Pengobatan.ID 
17/01/2007  00:50             3.072 Balai_Pengobatan.IND 
17/01/2007  00:50             1.536 Balai_Pengobatan.MAP 
17/01/2007  00:50               261 Balai_Pengobatan.TAB 
29/12/2006  18:41                93 Browser.bas 
13/01/2007  09:51               233 Btm.TAB 
12/01/2007  23:25        95.212.444 Btm.tif 
06/12/2006  22:12         2.556.994 BTN.BMP 
17/01/2007  19:24             5.858 Develop.WOR 
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15/01/2007  19:15               282 Gereja.DAT 
15/01/2007  19:15                 8 Gereja.ID 
15/01/2007  19:15             2.560 Gereja.IND 
15/01/2007  19:15             2.048 Gereja.MAP 
15/01/2007  19:15               220 Gereja.TAB 
31/12/2006  22:00         2.662.314 Graphic1.ico 
29/12/2006  09:11               277 info.mb 
29/12/2006  09:11               802 info.MBX 
14/01/2007  12:55               344 Jalan.DAT 
15/01/2007  12:59                24 Jalan.ID 
15/01/2007  12:59             1.536 Jalan.IND 
15/01/2007  12:59             1.536 Jalan.MAP 
15/01/2007  12:59               179 Jalan.TAB 
17/01/2007  00:50               243 Kelurahan.DAT 
17/01/2007  00:29                 4 Kelurahan.ID 
17/01/2007  00:50             3.072 Kelurahan.IND 
17/01/2007  00:29             1.536 Kelurahan.MAP 
17/01/2007  00:50               255 Kelurahan.TAB 
29/12/2006  18:41            35.039 MapBasic.bas 
17/01/2007  04:34           122.415 Mapviewform.frm 
17/01/2007  04:34         2.662.326 Mapviewform.frx 
14/01/2007  13:45               232 Masjid.DAT 
14/01/2007  09:49                 8 Masjid.ID 
14/01/2007  13:45             2.560 Masjid.IND 
14/01/2007  09:49             2.560 Masjid.MAP 
14/01/2007  13:45               220 Masjid.TAB 
15/01/2007  10:44               203 MSSCCPRJ.SCC 
16/01/2007  01:15               149 Pasar.DAT 
16/01/2007  01:15                 4 Pasar.ID 
16/01/2007  01:15             2.048 Pasar.IND 
16/01/2007  01:15             1.536 Pasar.MAP 
16/01/2007  01:15               185 Pasar.TAB 
17/01/2007  01:45               416 Penduduk.DAT 
17/01/2007  01:45                 8 Penduduk.ID 
17/01/2007  02:23             2.048 Penduduk.IND 
17/01/2007  01:45             2.048 Penduduk.MAP 
17/01/2007  02:23               265 Penduduk.TAB 
13/01/2007  10:10               149 Perumahan.DAT 
13/01/2007  22:27                 4 Perumahan.ID 
13/01/2007  22:27             2.048 Perumahan.IND 
13/01/2007  22:27             2.560 Perumahan.MAP 
13/01/2007  22:27               187 Perumahan.TAB 
29/12/2006  18:41                94 PrintOut.bas 
15/01/2007  12:59             1.954 Ruko.DAT 
15/01/2007  12:49                40 Ruko.ID 
15/01/2007  12:59             2.048 Ruko.IND 
15/01/2007  12:49             2.048 Ruko.MAP 
15/01/2007  12:59               258 Ruko.TAB 
17/01/2007  00:05               390 Sekolah.DAT 
17/01/2007  00:05                12 Sekolah.ID 
17/01/2007  00:05             3.072 Sekolah.IND 
17/01/2007  00:05             2.048 Sekolah.MAP 
17/01/2007  00:05               253 Sekolah.TAB 
15/01/2007  13:41               281 Vihara.DAT 
15/01/2007  13:41                 4 Vihara.ID 
15/01/2007  13:54             2.048 Vihara.IND 
15/01/2007  13:41             2.048 Vihara.MAP 
15/01/2007  13:54               220 Vihara.TAB 
              78 File(s)    108.695.829 bytes 
               2 Dir(s)   2.978.115.584 bytes free 

C.2.2. Isi Subdirektori : C:\ TA IF-0607-1.16\Dokumentasi 
E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi>dir 
 Volume in drive E is RCK 
 Volume Serial Number is 7436-DA4C 
 
 Directory of E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi 
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12/01/2007  22:32    <DIR>          . 
12/01/2007  22:32    <DIR>          .. 
17/01/2007  19:44    <DIR>          Gambar 
17/01/2007  20:59    <DIR>          Laporan 
12/01/2007  22:32    <DIR>          Logbook 
12/01/2007  22:32    <DIR>          Slide 
               0 File(s)              0 bytes 
               6 Dir(s)   2.978.115.584 bytes free 

C.2.2.1. Isi Subsubdirektori : C:\TA IF-0607-1.16\Gambar 
E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi\Gambar>dir 
 Volume in drive E is RCK 
 Volume Serial Number is 7436-DA4C 
 
 Directory of E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi\Gambar 
 
17/01/2007  19:44    <DIR>          . 
17/01/2007  19:44    <DIR>          .. 
15/11/2006  09:05            18.792 Backup_of_Backup_of_Layar.cdr 
21/11/2006  23:01            19.486 Backup_of_Layar.cdr 
17/01/2007  19:44           342.016 DFD.vsd 
15/11/2006  09:22            18.804 Layar.cdr 
               4 File(s)        399.098 bytes 
               2 Dir(s)   2.978.062.336 bytes free 

C.2.2.2. Isi Subsubdirektori : C:\TA IF-0607-1.16\Laporan 
E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi\Laporan>dir 
 Volume in drive E is RCK 
 Volume Serial Number is 7436-DA4C 
 
 Directory of E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi\Laporan 
 
17/01/2007  21:15    <DIR>          . 
17/01/2007  21:15    <DIR>          .. 
17/01/2007  19:20           102.400 Bab 1&2.doc 
17/01/2007  19:20           253.440 Bab 3.doc 
17/01/2007  19:03           366.080 Bab 4.doc 
17/01/2007  19:19            40.448 Bab 5.doc 
15/01/2007  01:22            24.064 Bab 6.doc 
17/01/2007  19:44           689.664 Lampiran A&B.doc 
17/01/2007  21:15            50.176 Lampiran C.doc 
15/01/2007  02:02            53.248 Lampiran D.doc 
19/12/2006  19:29            19.968 Lampiran E.doc 
29/12/2006  22:37           123.904 Lampiran F.doc 
21/12/2006  14:41            19.968 Lampiran G.doc 
10/11/2006  12:14            38.400 sampul Laporan TA .doc 
15/11/2006  07:56            38.400 sampul revisi LaporanTA .doc 
              13 File(s)      1.820.160 bytes 
               2 Dir(s)   2.978.062.336 bytes free 

C.2.2.3. Isi Subsubdirektori : C:\TA IF-0607-1.16\Logbook 
E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi\Logbook>dir 
 Volume in drive E is RCK 
 Volume Serial Number is 7436-DA4C 
 
 Directory of E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi\Logbook 
 
12/01/2007  22:32    <DIR>          . 
12/01/2007  22:32    <DIR>          .. 
08/09/2006  14:11            37.376 mg_1.doc 
01/12/2006  06:16            40.960 mg_10.doc 
14/12/2006  22:54            40.960 mg_11.doc 
14/12/2006  22:54            41.472 mg_12.doc 
22/12/2006  10:51            39.936 mg_13.doc 
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05/01/2007  12:25            39.424 mg_14.doc 
11/01/2007  20:02            40.448 mg_15.doc 
15/09/2006  10:50            39.424 mg_2.doc 
22/09/2006  10:55            44.032 mg_3.doc 
29/09/2006  08:21            44.544 mg_4.doc 
04/10/2006  21:15            43.008 mg_5.doc 
10/11/2006  10:06            39.936 mg_7.doc 
24/11/2006  12:12            41.984 mg_9.doc 
              13 File(s)        533.504 bytes 
               2 Dir(s)   2.978.062.336 bytes free 

C.2.2.4. Isi Subsubdirektori : C:\TA IF-0607-1.16\Slide 
E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi\Slide>dir 
 Volume in drive E is RCK 
 Volume Serial Number is 7436-DA4C 
 
 Directory of E:\Kuliah RCK\TA IF-0607-1.16\Dokumentasi\Slide 
 
12/01/2007  22:32    <DIR>          . 
12/01/2007  22:32    <DIR>          .. 
21/09/2006  08:31            92.160 IF-0607-1.16 Bab1&2.ppt 
08/11/2006  18:53           251.904 IF-0607-1.16 Bab3.ppt 
26/11/2006  00:12           240.128 IF-0607-1.16 Bab4.ppt 
               3 File(s)        584.192 bytes 
               2 Dir(s)   2.978.062.336 bytes free 

C.3. File Instalasi 

Berisi semua file yang anda buat sehubungan untuk instalasi aplikasi ini. Bagian ini akan berisi hasil 

“dumb” isi setiap direktori yang bukan diketik, melainkan dilakukan dengan progam/perintah . 
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Lampiran D Dokumen Rinci Testing 

 

D.1. Tim penguji 

1. Dewi Lestari (EW) 

2. Fitria Suryani (F3) 

 

D.2. Hasil Rinci Pengujian  

No. No. 

Fungsi 

Deskripsi 

Fungsional 

Kelompok Uji Prosedur & 

Kasus uji 

Hasil yang diharap Hasil Test Tester Tgl Testing Keterangan 

1 F1 Cari 

Perumahan 

Normal Isi nama 

perumahan 

Muncul lokasi 

perumahan 

Diterima EW 

F3 

20 Januari 2007  

          

2 F2 Cari Rumah 

(Alamat) 

Normal Isi alamat  Muncul lokasi atau 

alamat yang dicari 

beserta informasinya 

(no telp) 

Diterima EW 

F3 

20 Januari 2007  

          

3 F3 Cari Jalan  Normal Isi nama 

jalan 

Muncul lokasi jalan 

yang dicari beserta 

informasinya 

(nama perumahan jika 

nama jalan tersebut 

berada di dalam 

perumahan) 

Diterima EW 

F3 

1 Februari 2007  

          

4 F4 Cari Tempat 

Ibadah  

Normal Isi nama 

Tempat 

Ibadah 

Muncul lokasi tempat 

ibadah yang dicari 

beserta informasinya 

(alamat) 

Diterima EW 

F3 

1 Februari 2007  
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No. No. 

Fungsi 

Deskripsi 

Fungsional 

Kelompok Uji Prosedur & 

Kasus uji 

Hasil yang diharap Hasil Test Tester Tgl Testing Keterangan 

5 F5 Cari Pasar Normal Isi nama 

pasar 

Muncul Lokasi pasar 

yang dicari beserta 

informasinya (alamat) 

Diterima EW 

F3 

20 Januari 2007  

          

6 F6 Cari Balai 

Pengobatan 

Normal Isi nama 

Balai 

pengobatan 

Muncul Lokasi balai 

pengobatan yang dicari 

beserta informasinya 

(alamat, no telp, nama 

jalan) 

Diterima EW 

F3 

20 Januari 2007  

          

7 F7 Cari Sekolah Normal Isi nama 

sekolah 

Muncul Lokasi sekolah 

yang dicari beserta 

informasinya (no telp, 

alamat) 

Diterima EW 

F3 

20 Januari 2007  

          

8 F8 Cari Penduduk Normal Isi nama 

penduduk  + 

alamat 

Muncul rumah 

penduduk dengan 

alamat tertentu beserta 

informasinya 

(no telp) 

Diterima EW 

F3 

1 Februari 2007  

          

9 F9 Cari 

Kelurahan 

Normal Isi nama 

kelurahan 

Muncul Lokasi 

kelurahan yang dicari 

beserta informasinya 

(no telp, alamat) 

Diterima EW 

F3 

20 Januari 2007  
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Lampiran E Pembuatan Objek dan Tabel pada MapInfo 

E.1  Pengaturan Data Dan Peta 

Untuk menggunakan MapInfo, diperlukan file yang berisi peta dan arsip-arsip lainnya yang didapat 

dari MapInfo atau dapat dibuat sendiri dengan berbagai tool drawing. MapInfo akan mengorganisir 

semua informasi yang ada, apakah tekstual, grafis atau dalam bentuk tabel. Masing-masing tabel 

dikelompokkan oleh MapInfo yang dapat berupa file peta atau database. 

 

Semua proses dalam MapInfo dimulai saat kita membuka satu atau lebih tabel. 

E.1.1 File Yang Menyusun Tabel 

Dalam MapInfo file yang dimaksud sama dengan tabel. Tabel ini sedikitnya terdiri dari dua jenis file 

yaitu : • File.tab: file ini menguraikan struktur tabel. File.tab merupakan suatu file text berukuran kecil yang 

menggambarkan format file pada data. • File.dat atau file.wks, dbf, xls: file ini merupakan tabulator data.  

 

Jika kita bekerja menggunakan dBASE/FoxBASE, deliminated ASCII, lotus 1-2-3, Microsoft Excel, 

atau file Microsoft Access, maka MapInfo akan membentuk file.tab dan file spreadsheet.  

Tabel raster akan terbentuk jika membuat tabel dari file yang  berekstension seperti bmp,tif,atau gif dan 

MapInfo akan menentukan koordinat X dan Y. 

Jika grafik objek telah ada pada tabel, akan didapatkan dua file tambahan yang diasosiasikan dengan 

tabel: • File.map: file ini mengambarkan objek grafik. • File.id: file referensi silang yang menghubungkan data dengan objek. 

Tabel juga memungkinkan untuk memasukkan file index untuk proses pencarian objek pada peta 

dengan mengunakan perintah find. 

E.1.2 Membuat Tabel 

Dalam MapInfo, secara default akan menampilkan Quick Start. 

 
Gambar E.1 Quick Start 

 

Untuk pembuatan file  MapInfo dilakukan melalui File -> New Tabel, akan muncul tampilan seperti 

berikut: 
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Gambar E.2 New Tabel 

 

Klik tombol Create akan muncul kotak dialog sebagai berikut: 

 

Gambar E.3 New Tabel Struktur 

 

Buatlah layer yang diperlukan, berdasarkan utilitas peta yang akan didigitasi. Satu layer dalam 

MapInfo sama dengan satu buah tabel. 

 

Klik tombol Projection, secara default akan muncul kotak dialog berikut: 

 
Gambar E.4 Data spasial dalam system koordinat geografi dengan spheroid WGS84 

 

Proyeksi adalah suatu metoda/cara dalam usaha mendapatkan bentuk ubahan dari dimensi tertentu 

menjadi bentuk dimensi yang lain secara sistimatik. 

  

Biasanya Proyeksi digunakan untuk: 
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• Digitasi peta dengan proyeksi yang ekplisit. • Mengimport file DXF dengan proyeksi yang eksplisit. • Menjalankan aplikasi GIS yang membutuhkan tingkat presisi geografi yang diberikan oleh proyeksi 

(Lintang dan Bujur). • Digunakan untuk mengubah peta yang akan dijadikan output. 

 

Proyeksi tidak digunakan untuk peta non bumi, dimana koordinatnya tidak memiliki referensi untuk 

ditempatkan di permukaan bumi. 

 

 
Gambar E.5 Data spasial mempunyai Proyeksi UTM terletak pada Zone 48 selatan 

 

 
Gambar E.6 Data Spasial terletak pada bidang kertas sembarang  

yang biasanya berskala besar (1:100) 

 

Gambar E.4 dan E.5 mempunyai transformasi benar karena mempunyai referensi Elipsoid WGS 84, 

tetapi gambar E.6 tidak memiliki hubungan apapun dengan gambar E.4 dan E.5. Untuk melakukan 

transformasi geografi ke UTM dan sebaliknya dapat dilakukan dengan mengubah antara tampilan E.4 

atau E.5 dan sebaliknya. 

 

Klik segitiga pada Category, pilih Non-Earth. Dalam Category Members pilih Non-Earth(meters). 

Selanjutnya mengisi batasan dari absis dan ordinat. 

 
Gambar E.7 Tampilan koordinat Bound 
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Angka-angka tersebut didapat dari koordinat pojok kiri bawah dan pojok kanan atas. Lalu klik OK dan 

kita kembali ke Gambar E.3. isilah frame Field Information seduai informasi yang ingin ditampilkan 

pada tabel yang akan dibuat. 

E.1.3 Membuka File dan Tabel 

Untuk bekerja pada data, langkah pertama adalah membuka file atau tabel informasi yang kita 

inginkan. Pilih File -> Open… .  

 
Gambar E.8 Open Tabel Dialog 

 

Jika pada posisi Quick Start Dialog (Gambar E.1.2.1), pilih tombol Open a Tabel, selanjutnya Open 

Tabel Dialog dimunculkan. 

E.1.4 Membuka File MapInfo Existing 

Walaupun tabel pada MapInfo terdiri atas dua atau lebih komponen file (*.tab, *.dat, *.map dan 

lainnya), hanya file *.tab yang dimunculkan pada box File Name dari Open Tabel Dialog. MapInfo 

memberikan cara menggontrol tampilan tabel. Dengan menggunakan Preffered View List box pada 

Tabel Open Dialog, kita dapat menampilkan spesifikasi yang diinginkan. Berikut ini pilihan tampilan: 

 • Automatic -> MapInfo memilih tampilan  yang paling efektif. Jika data dalam bentuk peta (seperti 

objek grafik yang dilampirkan pada data) MapInfo membuka tabel pada Map Window. Jika data 

tidak dalam bentuk peta, MapInfo akan mencoba membuka tabel pada Browser Window. Apabila 

tabel tidak dapat dipetakan dan dibrowser, MapInfo akan membuka tabel dengan menggunakan No 

View Option (tidak ada data yang ditampilkan). • Browser -> MapInfo mencoba membuka tabel pada Browser Window. • Current Mapper -> MapInfo menambahkan data pada map yang sudah terbuka. • New Mapper -> MapInfo membuka tabel dengan lembar map yang baru. • No View -> MapInfo membuka tabel, tapi tidak ada data  yang ditampilkan. 
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E.1.5 Data Yang Dapat Dipakai MapInfo 

MapInfo memperbolehkan menggunakan data yang dibuat dalam format file yang lain. Ketika data 

dibawa ke MapInfo untuk pertama kalinya, dibutuhkan spesifikasi untuk memformat data tersebut. 

 

MapInfo membuat struktur tabel untuk data. Ketika tabel dibuka di work session, MapInfo akan 

memperlakukan file-file tersebut seperti file-file yang berasal dari format MapInfo. Jika sewaktu-waktu 

file tersebut dibuka lagi, MapInfo akan menampilkan pesan “Tabel definition already exists. Overwrite 

it?”. 

 

Untuk menampilkan tabel ke dalam Map Window, data harus terdiri atas koordinat, dapat ditambahkan 

dengan menggunakan MapInfo. Proses ini dinamakan geocoding. 

 

MapInfo mendukung tampilan raster image. Raster image merupakan gambar yang terkomputerisasi. 

Image grafik tersebut dapat digunakan sebagai background untuk peta yang akan di buat MapInfo. 

Ketika raster image dibawa ke MapInfo, perlu dilakukan register (spesifikasi koordinat peta) sehingga 

MapInfo mampu menampilkan dengan sebenarnya. Ketika memilih format raster image dari Open 

Tabel Dialog, akan dibawa ke Image Registration Dialog. Penentuan koordinat yang diinginkan dapat 

dilakukan. Ketika proses registrasi dilakukan, yakni ketika prodses membuat file .tab untuk image, 

tabel tersebut masih dapat dibuka melalui Map Window. 

E.1.6 Layer-Layer Peta 

Peta komputer dikendalikan dengan layer. Layer seperti kertas transparan yang saling menutupi satu 

sama lainnya. Setiap layer terdiri atas aspek yang berbeda. Dalam MapInfo dimulai dengan membuka 

tabel data dan menampilkannya pada Map Windows. Setiap tabel ditampilkan secara menyebar pada 

layer. Setiap layer terdiri atas Map Objek yang berbeda-beda, seperti wilayah, titik, garis, dan teks. 

E.2 Map Window, Browser Window, Graph Window, Layout Window dan 
Legend Window 

Untuk menampilkan tabel pada layer, MapInfo menyediakan bentuk yang berbeda untuk menampilkan 

data dengan Map Window, Browser Window atau Graph Window. 

E.2.1 Map Window 

Map Window memberikan informasi berdasarkan peta konvensional, jadi memungkinkan untuk 

memfisualisasikan pola geografi pada data.  

 

Map Window digunakan untuk menampilkan objek geografi pada tabel. Map Window bisa 

menampilkan informasi dari banyak tabel secara bersamaan, dengan tabel yang tersebar pada layer.  

 

Peta dapat dibuat sendiri atau dengan melakukan editing pada peta yang telah ada.  

Map Window bisa ditampilkan langsung melalui File -> Open… atau dengan menggunakan Window -

> Map Window. 

E.2.2 Browser Window 

Browser Window memberikan informasi dalam bentuk list tabulator. 

 

Browser Window digunakan untuk menampilkan dan manipulasi data yang disimpan dalam bentuk 

barisan dan kolom tradisional. Setiap kolom terdiri atas informasi mengenai data field., setiap baris 

terdiri atas informasi yang terkait dengan record single.Record dapat diedit, dikopi, ditambah atau 

dihapus.  

 

Untuk membuka browser secara langsung adalah dengan Window -> New Browser Window. 
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E.2.3 Graph Window 

Graph Window memberikan informasi berbentuk grafik, memungkinkan untuk visualisasi dan 

membuat perbandingan terhadap pola-pola numeric. 

 

Graph Window digunakan untuk menampilkan hubungan statistic dalam bentuk grafik. Dapat dibuat 

line graph, grafik batang vertical dan horizontal, pie grafik, dan scatter grafik. 

 

Untuk membuka Graph Window, pilih Window -> New Graph Window. 

E.2.4 Layout Window 

Layout Window memungkinkan untukmenggabungkan Browser, Map Window, Graph Window, dan 

objek grafik lainnya kedalam satu layout yang bisa dikirim ke printer ataupun plotter.  

 

Untuk  menggunakan Layout window, pilih Window -> New Layout Window. 

E.2.5 Legend Window 

Legend Window menampilkan legend untuk melakukan kartografi data pada peta. Legend dapat dibuat 

pada beberapa layer melalui Map Window. Modifikasi legend dapat dilakukan melalui shortcut dengan 

meng-klik kanan legend window atau melalui Legend menu.  

 

Untuk membuat legend, pilih Map -> Create Legend. Untuk dapat menjalankan perintah ini Map 

Window harus aktif. 

E.3 Mendapat Data Dari Peta: Geocoding 

Untuk menampilkan data pada MapInfo, dibutuhkan data yang terdiri dari koordinat X dan Y sehingga 

MapInfo mengetahui posisi data pada peta. Proses penentuan koordinat peta dinamakan geocoding. 

MapInfo menentukan koordinat dengan melihat informasi geografi pada data dan informasi geografi 

pada tabel yang terdiri dari koordinat X dan Y. 

 

Setelah melakukan proses geocoding, maka record ini dapat ditampilkan pada Map Window. 

E.4 Objek Peta 

MapInfo terdiri atas layer pada objek peta, ada empat tipe dasar objek: • Region: objek yang membatasi area, termasuk polygon, ellips, dan persegi. Sebagai contoh, batasan 

Negara, batasan kode pos, wilayah penjualan. • Objek point: mempresentasikan lokasi tunggal data. Sebagai contoh, lokasi pelanggan, restaurant, 

tempat parker. • Objek garis: objek yang menggambarkan jarak, termasuk garis, polylines, dan lengkungan. • Teks objek: merupakan teks yang menggambarkan peta atau objek lainnya, seperti label dan title. 
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Lampiran F Penambahan Data pada Peta 

F.1 Membuka File dan Tabel 

Untuk memulai penambahan data pada peta, buka file.wor. Membuka file dapat dilakukan melalui 

Quick Start atau File->Open…. 

 

 
Gambar F.1 Open Table Dialog 

 
Files of types pilih Workspace dengan nama file Batam.wor. Setelah itu klok tombol Open dan akan 

muncul tampilan sebagai berikut: 

 

 
Gambar F.2 Tabel Batam 
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F.2 Membuat Region 

Untuk mempermudah kita dalam pembuatan region, kita perbesar tampilan petanya sesuai.Sebagai 

contoh kita membuat region perumahan Tiban I. Pertama kita klik zoom-in too box main. 

 

Kedua, kita klik menu Layer Control pada toolbox main. Kemudian akan muncul Layer Control Box. 

Kita pilih layer perumahan, karena kita akan membuat region perumahan baru. 

 

 
Gambar F.3 Tabel Batam + Zoom In 

 

 
Gambar F.4 Layer Control Box 

 

Klik menu Rectangle pada Toolbox Drawing, setelah itu buat region Perumahan Tiban I. Warna 

default region adalah putih. Untuk merubah warnanya, pilih Option->Region Style , pattern pada 

frame fill pilih N. Jangan lupa klik region yang ingin kita ubah warnanya. 
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Gambar F.5 Pembuatan Region 

F.3 Menambah Data pada Peta 

Untuk menambah data peta kita buka Browser Window perumahan. Apabila region yang baru kita buat 

kita klik, pada browser map akan ditandai. 

 

 
Gambar F.6 Menambah data pada browser window 

F.4 Membuat Symbol 

Untuk membuat symbol, jangan lupa ubah layer yang akan diberi simbol. Sebagai contoh kita membuat 

symbol tempat ibadah (masjid) di Perumahn Tiban I. pertama kita klik menu Symbol pada Toolbox 

Drawing. Kita klik di titik sembarang untuk meletakan symbol.  

 

Untuk merubah symbol klik menu Option->Symbol Style. Pada Font pilih Custom Symbol dan pilih 

simbol masjid dengan ukuran 14. 
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Gambar F.7 Tabel Batam dengan penambahan symbol 

F.5 Membuat Line atau Jalan 

Untuk membuat jalan, pertama kita ubah layer. Kemudian pilih menu Line pada Toolbox 

Drawing.Letakkan garis di sembarang titik. 

 
Gambar F.8 Pembuatan line atau jalan 
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